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About licensing

To use your Perceptive Intelligent Capture (PIC) system, you need a valid license file based on the required
applications and features.

This license file must be present in the local license directory of each PIC server and workstation. In addition,
each server and workstation must have access to a common shared network location that maintains the
runtime license.

About the local license directory

Each PIC server or workstation includes alocal license directory. PIC applications automatically search in
the local license directory for a valid license file on startup.

Note: The default location is [drive:]\[installation directory\Components\Cairo.

For more information, see About the shared license directory.

What is the master license server?

A valid license file must include hardware binding to one or more servers. The server to which a license binds
is a master license server. Programs running on a master license server, including Runtime Server, other PIC
programs or tools, or a third-party OEM tool have the ability to create a runtime license file and update the
timestamp within an existing runtime license file.

You can grant master rights to any program when one or more of the following conditions apply.

« Thelocal hard disk ID matches the corresponding ID specified in the master license file.
« Thelocal MAC address ID matches the corresponding ID specified in the master license file.

« The master license file contains the Hardware Binding = Off parameter that allows PIC to work
without hardware binding.

Hardware binding

PIC licensing supports different options for binding server hardware to the license file. The following table lists
the master license entries that determine the hardware binding type.

If a section is not present, the corresponding hardware binding option is switched off.

Hardware Binding Type License Section and Parameter Name

MAC address Section: [License for Document Processing]

Parameter: Secondary MAC Address

Hard disk ID Section: [License for Document Processing]

Parameter: Secondary HD Serial Number




Hardware Binding Type License Section and Parameter Name

Master license file parameter that allows Section: [License for Document Processing]

the system to work without hardware binding Parameter: Hardware Binding

Check the master licensing status

Runtime Server machines that have a licensing server status can generate runtime licenses. To check the
licensing status of a workstation, complete one of the following steps.

For more information, see “System Monitoring” in the Perceptive Intelligent Capture Runtime Server Help.
« Inthe MMC administration console, locate the required Runtime Server machine node.
Note: Nodes marked with a golden key i_"".i have master status.
o Check the Runtime Server log file monitored through the system monitoring service.

Runtime Server log file messages

The system monitoring service logs the following messages.

Message

Description

Security check passed. Master
access rights granted.

Licensing server status granted through license file parameter,
Hardware Binding = Off, that allows the system to work
without any hardware binding.

Security check for MAC address
"NNNN" passed. Master access
rights granted.

Licensing server status granted through MAC address.

Security check for HDD serial number
"NNNN" passed. Master access
rights granted.

Licensing server status granted through hard disk ID.

Security check for primary hardware
key "NNNN" passed. Master access
rights granted.

Licensing server status granted through primary hardware key.

Security check for secondary
hardware key "NNNN" passed.
Master access rights granted.

Licensing server status granted through secondary hardware key.

No message

Licensing server status has not been granted.




What is the runtime license file?

The runtime license file, Runtime.lic, is a shared file. A designated master license server creates the
Runtime.lic based on the local license file and appends timestamp and counter sections.

Generally, the Runtime Server service manager, DstMgr.exe, on the master license server maintains the
timestamp in the runtime license file. Any PIC application running on the master license server is able to
generate and update a runtime license file for the following reasons.

« The runtime license file does not exist.

« Thetimestamp is expired.

« Theruntime license file is invalid.

When an PIC application on any server or workstation attempts a licensed action, it performs the following
checks.

« Thelocal license file matches the runtime license file.

« Thetimestamp and counters in the runtime license file are valid.

« Thelicense file allows for the specific licensed action.

Example

When opening a batch in Verifier or Runtime Server, the batch control component checks the
timestamp and the client count section in the shared license file. If there are an excessive number of
modules open or if the timestamp in the license file is expired, the open operation for a batch fails.

Note: Runtime Server instances do not have to be running or polling for the master license server to
generate or update the license file, but the service must have been launched.

About the runtime license file update frequency

For performance and availability reasons, the licensing subsystem does not update the runtime license file
each time the program invokes a licensed function. The program stores incremented counters locally in
memory and through special licensing backups.

The license file updates according to the following rules.

1. Thefirst time PIC invokes any licensed function after program launch.

2. Then the license file updates according to the time interval set in the master license file parameter
Update Frequency in Minutes. This includes a 20 percent divergence to desynchronize shared

access to the license file. The default update frequency for Update Frequency in Minutesis 20
minutes.

You may need to adjust the Update Frequency in Minutes parameter based on the project size. For
large projects, a higher value reduces the number of simultaneous accesses to the runtime license file. For
small projects, a lower value delivers up-to-date counter values.



About the runtime license file timestamp

The runtime license file stores the timestamp in Coordinated Universal Time (UTC) format. It identifies
whether the runtime license file is valid and can grant licensing access to non-licensed servers.

Example
[Timestamp] UTC = 7F07D70508120F34 Updated = 2014-11-08 18:15:52
Check = -1353187175
About the license file validity period

The [CheckPeriod] sectionin the license file defines the runtime license file’s validity period. By default,
the validity period is 30 minutes, which means that the timestamp must be less than 30 minutes old for that
runtime license to be valid.

Note: Toincrease this value in the license file, contact your Lexmark Enterprise Software representative.

Example

[CheckPeriod] Value = 360 Check = -871790541

The value parameter specifies the timestamp validity time frame in minutes.

About the shared license directory
The shared license directory contains the runtime license file.

All PIC servers and workstations require read, write, modify, and execute rights on the shared license
directory to read the runtime license file and update the counters.

You can specify the shared license directory in the PIC Runtime Server MMC administration console, in PIC
Verifier, orin PIC Designer.

Specify the shared license directory in the MMC administration console

To specify the shared license directory on each PIC server or workstation in the PIC Runtime Server MMC
administration console, complete the following steps.

1. Onthe Options menu, click License.
2. Inthe License Settings dialog box, select Use specified path.
3. Inthe Path box, type or browse to a path for the appropriate license directory, and then click OK.

Specify the shared license directory in PIC Verifier or PIC Designer

To specify the shared license directory on each PIC server or workstation in the PIC Verifier or PIC Designer,
complete the following steps.

1. Onthe Options menu, click License.



2. Inthe License Settings dialog box, select Use specified path.
3. Inthe Path box, type or browse to a path for the appropriate license directory, and then click OK.

About demonstration and test licenses
Lexmark provides one general demonstration license for each organization.

You can order additional demonstration licenses as needed. Demonstration licenses without hardware binding
to a specific server are available for temporary use and are valid for three months.

Request a license

Torequest a license, on the designated PIC master license server, complete the following steps.

Note: Licenses are tied to hardware. PIC installations on virtual machines require you to assign the
resources statically.

1. Ensure that you are logged in with an account which has administrator rights.

2. Tocreate aDump.log file, click Start > All Programs > Lexmark > Perceptive Intelligent Capture
> Tools > Check Hardware ID .

3. Send an email to Enterprise Software Product Support (es_support@Ilexmark.com) and provide the
following information.

« The MAC address and HDD serial number information provided in the Dump.log file. The tool
selects the HDD serial number of the fixed drive on which Windows is installed.

« The number of Runtime Servers, Verifier, and Web Verifier workstations.

« The required components and engines. For more information, see License-protected components
and engines.

Copy the license file to local license directories

Each standalone PIC installation must include a copy of the license file in its local license directory. When
you receive your permanent license file, complete the following steps.

1. Oneach Runtime server, launch PIC Runtime Service Management Console and stop all PIC
Runtime Server instances.
2. Onall machines, close all PIC Verifier and PIC Web Verifier instances.

3. Onthe designated PIC licensing server, stop the PIC Runtime Service Manager Windows service,
and then complete the following substeps.

1. Navigate to [drive:]\[Program directory]\Lexmark\Components\Cairo.

2. Remove the zCroDemo.lic demo license file and any other existing LIC files.

3. Copy the permanent license file to [drive:]\[Program directory]\Lexmark\Components\Cairo.
4

For PIC Web Verifier, on the web server, open a Command Prompt window and run iisreset
as an administrator.

5. Repeat the previous steps on all Runtime Servers, PIC Verifier and PIC Web Verifier
workstations.



Navigate to the shared license directory and remove the Runtime.lic runtime license file.
Restart all PIC applications and services.

Verify a license file

To verify that the new license file is in use, complete the following steps.

1.

2.
3.

Click Start > All Programs > Lexmark > Perceptive Intelligent Capture > Tools > Component
Version Info.

On the View menu, click Components Licensing Info.
In the License Files column, verify that the correct license file is in use.

License-protected components and engines

To use the following PIC Cairo and Cedar components and engines, you need a license file that contains the
corresponding license entries.

Classification engines

Analysis engines

Evaluation engines

Recognition engines

Supervised Learning

Email import in Runtime Server

Electronic, non-image documents in Runtime Server
Digit Booster engine

Kadmos 5 Server

Brainware Toolkit

Classification engines

PIC provides several classification engines to categorize your documents.

The available classification engines include the following.

Brainware Classify Engine
Layout Classify Engine

ASSA Classify Engine
Brainware Layout Classification
Forms Classify Engine

Phrase Classify Engine
Language Classify Engine
Image Size Classification
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Analysis engines
PIC provides several analysis engines to configure the extraction of values from header fields and tables.
The available analysis engines include the following.

« Associative Search Engine
« Brainware Table Extraction
o Check Analysis Engine

« Format Analysis Engine

« Table Analysis Engine

« Zone Analysis Engine

Evaluation engines

Specific analysis engines, such as the Format Analysis Engine and the Zone Analysis Engine, may use an
evaluation engine to determine the best candidate.

The available evaluation engines include the following.

« Brainware Extraction Engine

« Brainware Field Extraction Engine

Recognition engines

PIC provides several engines for the recognition of characters, marks and barcodes.
The available recognition engines include the following.

« ABBYY FineReader 11
« ABBYY FineReader 10
« Kadmos 5

Supervised Learning
Supervised Learning automatically creates and learns new document classes.

The Supervised Learning and the Learnset Manager require licenses for the following classification and
analysis engines.

« A classification engine for the classification of the base document class.

« Brainware Layout Engine for the classification of a derived document class.

« Associative Search Engine for both the classification of a derived document class and as an analysis
engine to extract the respective vendor supplier information.

« Format Analysis Engine and Brainware Extraction Engine for the evaluation of header fields.
« Brainware Table Extraction engine for the extraction of values from tables.
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Email import in Runtime Server

P1C Runtime Server provides the ability to automatically download emails from an email system and import
them into the system. The email importing feature requires the [E-mails Importing] license entry.

For more information, see “Download emails from Exchange server” in the Perceptive Intelligent Capture
Runtime Server Help.

Note: This feature is included in the demonstration license.

Electronic, non-image documents in Runtime Server

PIC provides the ability to process electronic, non-image documents, such as Microsoft Word, Microsoft
Excel, or PDF files.

This feature requires the [Cairo CIDoc] license entry.

For more information, see "Configure import settings" in the Perceptive Intelligent Capture Runtime Server
Help.

Note: This feature is included in the demonstration license.

Digit Booster engine

The Digit Booster engine enhances OCR quality on low quality documents.
The engine requires the [Field Digit Booster] license entry.

Kadmos 5 Server

The Kadmos 5 engine recognizes handwritten document forms and material containing handwritten zones. It
offers support and optimization for different languages.

PIC uses Kadmos 5 Client Edition. This standard version is for one user and one processor at a time.

A Server Edition is available, which is capable of processing documents with multiple users and multiple
processors. The Server Edition requires a separate installation Add-on and a separate license.

Contact your Lexmark Enterprise Software representative for more information.

Brainware Toolkit

The Brainware Toolkit provides external programs access to core PIC functions and ASE (Associative
Search Engine) classification and search capabilities. The Brainware Toolkit requires additional licensing.

A second licensing option is available specifically for Brainware Toolkit. You can license Brainware Toolkit
with a dedicated secondary license file in the [drive:]\[installation directory\Components\Bwe directory.

This secondary license file must be a valid license file and is used solely for the activation of the Brainware
Toolkit to external programs.

Note: This feature is not included in the demonstration license.
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About license counters

PI1C maintains license counters to track the number of times specific licensed actions execute. The
[License for DocumentProcessing] section of the license file includes all active counters.

Each counter is available as overall or period counter.

If an active counter exceeds the indicated value, the system blocks the corresponding licensed action.
PI1C maintains inactive counters, but does not consider them when checking the corresponding licensed
action’s validity.

Note: PIC does not increment inactive engine-level counters, such as for the Check Analysis Engine.

The system counts the following nine actions.

« Processed Pages, such as pages that were either imported or processed with optical character
recognition (OCR).

« Processed Documents, such as documents that were either OCRed, classified, extracted, or exported.

« Imported pages

o OCRed pages

« OCRed documents

« Classified documents

« Extracted documents

« Exported documents

o Documents validated in PIC Verifier

About overall counters

For overall counters, the system allows exactly the specified number of licensed actions without a time
limitation. The Overall prefix defines an overall counter.

Example
The master license file contains the following entry.
Overall Classified Documents = 100000
This entry allows classification attempts on 100,000 different documents. By default, reprocessing of

an already processed document does not increment the counter.

Note: A licensing warning displays if the license usage reaches 90 percent. A licensing error occurs when
license usage exceeds 100 percent.
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About period counters

For period counter types, the system allows processing of the specified number of licensed actions multiplied
by the Licensing Period in Days valueinthesame [License for Document Processing]
section of the master license file.

PIC then processes this number of documents within “Licensing Period in Days”. As soon as the “Licensing
Period in Days” period elapses, a new period of the same duration starts and PIC resets the previous period
counters.

Period counters allow a licensed action to perform a specified number of times within a specified period. The
Licensing Period in DaysVvalueinthe [License for Document Processing] section of the
license file defines the period. The first licensing period starts with the license file installation. During the initial
licensing period, the total number of licensed actions allowed is the counter value multiplied by the number of
days in the licensing period. As soon as the licensing period elapses, a new period of the same duration starts
with reset counters. The per Day suffix defines a period counter.

If your PIC system uses a period counter, the license does not transfer the unused pages or documents from
one licensing period to the next. A licensing warning displays if the license usage reaches 90 percent. A
licensing error occurs when license usage exceeds 120 percent.

Example
The master license file contains the following entries.

Licensing Period in Days = 90 OCRed Pages per Day = 3000

These entries allow PIC to OCR 270,000 pages (90 x 3000) within each 90 days licensing period.

About engine level counters

The Check Analysis Engine provides extended counters at the engine level. Each engine-level counter is
available as overall or period counter per document.

Engine level counters are only available if the corresponding engine header and counters are active in the
licensefile.

About incrementing counters for repeated processing
Each PIC workdoc document retains information about the licensed actions applied to the document.

When the licensing subsystem verifies a licensed action, such as classification, the system first checks
whether this action was previously applied to the document or page. If so, the system allows the action
without any further license verification or incrementing of the corresponding counter. This feature is also
active when you upgrade the license file.

14



Increment a counter when reprocessing

Toincrement a counter every time the system processes or reprocesses a document, complete the following
step.

o Verify thatthe License Counting by Reprocessing parameter exists inthe [License for
Document Processing] section of the master license file and the parameter value is set to 1.

Note: To request a license file that includes this feature, contact your Lexmark Enterprise Software
representative.

Check a license counter or parameter

To check a license file counter or parameter, complete one of the following steps.
For more information, see “SCBCdrLicenselnfoAccess” and “ReportLicensingStatus” in the Perceptive
Intelligent Capture Scripting Help.

« Use one of the following methods, provided by the SCBCdrLicenselnfoAccess object, in a PIC custom
script.
« GetLicenseCounterByID

« GetlLicenseCounterByName
« GetlLicenseValueByld
o GetlLicenseValueByName

Note: The methods “GetLicenseCounterByID” and “GetLicenseValueByld” are not available for
engine-level counters.

« Use the following method, provided by the SCBCdrPROJLib object, in a PIC custom script.
« ReportLicensingStatus

Note: The system increments both active and inactive license counters for evaluation purposes. The
system does not increment inactive counters on engine level.

About licensing notifications

PIC logs all critical licensing notifications and forwards them to the system monitoring service. The PIC
system monitoring can enable email notification to the system administrator list.

For more information, see “System Monitoring” in the Perceptive Intelligent Capture Runtime Server Help.

Security, performance, and availability of the licensing sub-system

The licensing subsystem implements the following methods to maintain security and availability of the shared
license counters.

« Every server or workstation that uses PIC-licensed functions verifies the consistency of the runtime
license file and is able to repair it if the file is invalid.

« Local licensing backups are periodically stored on each workstation.
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« Licensing backups are also stored in a section of each processed workdoc OLE stream.

« Thelicensing subsystem securely encodes and decodes licensing information and counters. This
prevents modifying or copying of the license file from one workstation to another.

« PIC programs and OEM tools store immediate backups of currently processed documents. If the
program terminates or does not respond any more, the counters restore at the next program start.

What is the unique workdoc identifier?

As a part of the licensing subsystem implementation, the workdoc interface provides a unique identifier stored
in the workdoc stream.

PIC generates an identifier when creating a new workdoc object and when adding new image or document
files to the workdoc.

The workdoc identifier is a 60-character string with the identifier generation date, time, and a dynamically
created UUID.
Example

2014-11-05-18-01-32-484-CA4B5BAT7-6488-4685-89D0-55C410DF1172

Access the unique workdoc identifier

To access this identifier from a PIC custom script, complete the following step.

o Use the public property UniqueID of the SCBCdrWorkdoc interface. If required, you can use the
UniquelID property to identify the document.

Example

Private Sub ScriptModule PreClassify(pWorkdoc As
SCBCdrPROJLib.SCBCdrWorkdoc) Dim strWorkdocID As String strWorkdocID =
pWorkdoc.UniqueID End Sub

Disable license maodification by Verifier clients

If the system encounters performance issues, you can disable license modifications initiated by PIC Verifier
clients. To disable license modification, complete the following step.

o Inthe masterlicensefile, inthe [License for Document Processing] section, verify that the
Disable Update for Verifier parameter exists.

Note: To request a license file that includes this feature, contact your Lexmark Enterprise Software
representative.
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